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Warning
- To reduce the risk of fire or electric shock, do not expose

this appliance to rain or moisture.

Caution
- The appliance is not intended for use by young children or infirm

persons without supervision.
- Young Children should be supervised to ensure that they do not

play appliance.
- Use of controls or adjustments or performance of procedures other

than those specified herein may result in hazardous radiation ex-
posure.

Industry Canada requirement
- This Class B digital apparatus complies with Canadian ICES-003.
- Cet appareil numérique de la classe B est conforme qa la norme à

NMB-003 du Canada.

FCC COMPLIANCE STATEMENT

Note
This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particu-
lar installation.If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interfer- ence by one or
more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit 
different from that to which the receiver is connected.

- Consult the dealer or an Authorized Service Center for help.

FCC WARNING
This equipment may generate or use radio frequency 
energy. Changes or modifications to this equipment may cause harm-
ful interference unless the modifications are expressly approved in the
instruction manual.

You could lose the authority to operate this equipment if an unautho-
rized change or modification is made.

- Changes or modifications not expressly approved by the party re-
sponsible for compliance could void the user's authority to operate
the equipment. 

- This MP3 player is for use only with UL listed personal computers
that have installation instructions detailing user installation of card
cage accessory.

Disposal of your old appliance

1. When this crossed-out wheeled bin symbol is attached to a product it
means the product is covered by the European Directive 2002/96/EC.

2. All electrical and electronic products should be disposed of separately
from the municipal waste stream via designated collection facilities
appointed by the government or the local authorities.

3. The correct disposal of your old appliance will help prevent potential
negative consequences for the environment and human health.

4. For more detailed information about disposal of your old appliance,
please contact your city office, waste disposal service or the shop
where you purchased the product.

- The lithium battery contains lithium and can explode if it is not properly
handled of disposed of. 

- Replace only with a battery of the type recommended by LG.

- Caution: Danger of explosion if battery is incorrectly replaced. Replace
only the rechargeable lithium battery with LG, Part No.(LGIP-411A).
Use of Another Cell May Present a Risk of Fire or Explosion. 

CAUTION
RISK OF ELECTRIC SHOCK 

DO NOT OPEN

CAUTION: TO REDUCE THE RISK 
OF ELECTRIC SHOCK

DO NOT REMOVE COVER (OR BACK)
NO USER-SERVICEABLE PARTS INSIDE

REFER SERVICING TO QUALIFIED SERVICE
PERSONNEL.

The working life of  this product is 7 years
since the date of purchase.
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IMPORTANT SAFETY INSTRUCTIONS

This product is manufactured to comply with the EMC
DIRECTIVE 2004/108/EC and Low voltage Directive
2006/95/EC.

European representative : 
LG Electronics Service Europe B.V. Veluwezoom 15,
1327 AE Almere, The Netherlands 
(Tel : +31-036-547-8940) 
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CAUTION
PLEASE READ AND OBSERVE ALL WARNINGS AND INSTRUCTIONS
IN THIS OWNER MANUAL AND THOSE MARKED ON THE UNIT. RE-
TAIN THIS BOOKLET FOR FUTURE REFERENCE.

This product has been designed and manufactured to assure per-
sonal safety. Improper use can result in electric shock or fire hazard.
The safeguards incorporated in this unit will protect you if you ob-
serve the following procedures for installation, use, and servicing.
This unit does not contain any parts that can be repaired by the user.

DO NOT REMOVE THE CABINET COVER, OR YOU MAY BE EXPOSED
TO DANGEROUS VOLTAGE. REFER SERVICING TO QUALIFIED SER-
VICE PERSONNEL ONLY.

1. Read these instructions.

- All these safety and operating instructions should be read before the
product is operated.

2. Keep these instructions.
- The safety, operating and use instructions should be retained for fu-

ture reference.

3. Heed all warnings.

- All warnings on the product and in the operating instructions should
be adhered to.

4. Follow all instructions.
- All operating and use instructions should be followed.

5. Do not use this apparatus near water

- For example: near a bath tub, wash bowl, kitchen sink,  laundry tub,
in a wet basement; or near a swimming pool;and like.

6. Clean only with dry cloth.

- Unplug this product from the wall outlet before cleaning.Do not use
liquid cleaners.

7. Do not block any ventilation openings. Install in accordance with
the manufacturer is instructions.

- Slots and openings in the cabinet are provided for ventilation and to
ensure reliable operation of the product and to protect it from over-
heating.

- The openings should never be blocked by placing the product on a
bed, sofa, rug or other similar surface.This product should not be
placed in a built-in installation ventilation is provided or the manufac-
turer instructions have been adhered to. 

- Important Safety Instructions

8. Do not install near any heat sources such as radiators, heat regis-
ters, stoves, or other apparatus (including amplifiers) that produce
heat.

9. Do not defeat the safety purpose of the polarized or grounding-
type plug. A polarized plug has two blades with one wider than the
other.A grounding type plug has two blades and a third grounding
prong. The wide blade or the third prong are provided for your
safety.

- If the provided plug does not fit into your outlet, consult
an electrician for replacement of the obsolete outlet.

10. Protect the power cord from being walked on or pinched particu-
larly at plugs, convenience receptacles, and the point where they
exit from the apparatus.

11. Only use attachments/accessories specified by the manufacturer.

12. Use only with the cart, stand, tripod, bracket, or table specified by
the manufacturer, or sold with apparatus.
- When a cart is used, use caution when moving the cart/apparatus com-
bination to avoid injury from tip over.

13. Unplug this apparatus during lightning storms or when unused for
long periods of time.

14. Refer all servicing to qualified service personnel.
Servicing is required when the apparatus has been damaged in
any way, such as power- supply cord or plug is damaged, liquid
has been spilled or objects have fallen into the apparatus, the ap-
paratus has been exposed to rain or moisture, does not operate
normally, or has been dropped.
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Please follow the safety tips closely to reduce the risk of accidents or damage to equipment.
Safety instructions are divided into Warning and Caution.
Keep this manual in an easily accessible place.

Do not use the Player and connect with the
cable or AC adapter when the rain is pouring
down and thunderstorms produce lightning. 

Do not use this product while driving.

Do not operate the Player near water, dust, or
soot.

Not following the safety tips may result
in a light accident or damage.

Not following the safety tips may result
in death or serious injury.

Do not place the player near a magnet or within the
magnetic field.

Note that the player may malfunction in an electro-
static environment.

Do not disconnect the USB cable. Do not turn off the
player while the USB cable is connected. Otherwise,
the data may get lost.

Back up important data. (Note that the manufacturer
is not responsible for the loss of major data caused
by the user's mistake.)

Do not insert a metallic object (coins or hair pins,
etc.) or flammable objects in the product.
Do not drop such objects on the product either.

Do not place an object on the product. 

Keep this product away from heat.

Clean the Player with soft cloth.

Do not disassemble, repair, or remodel the product.

Do not drop  an object or give shock on the
product.

Do not use the earphones loud while
walking,especially on the crosswalks.

Stop using earphones or lower the 
volume when you have ringing in your ears.

Careful that headphones or earphones do not
slip into the subway doors or automatic doors.

Listening to the music loud for a long time may
compromise your hearing ability.

Do not use earphones while riding bicycles
and motor cycles or driving a car.

Check the volume before using a 
headphone. If headphones are used at high
volume for more than 30 minutes, it may result
in noise induced hearing damage.

Warning Caution

Warning Caution
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Features

Portable Data Storage
Easy storage and transfer of any file type.

USB 1.1 and 2.0
You can download files at a fast speed. (USB  2.0 high speed)

LG 3D Sound
3D sound effects, low tones, and low frequency sound provide greater
sound quality.

Various background setting
Users can select a desired background image among various sup-
ported items or even create unique one to their likings. 

Text Viewer
Convenient display of text files (.txt) for reading on the go.

TTS(Text To Speech) function
With TTS function, you can convert language text into speech and lis-
ten to it. It allows people with visual impairments or reading disabilities
to listen to written works on the player. 

2.2" Color TFT LCD
Photos and video are reproduced in vivid detail on the highly portable
260,000 color TFT LCD.

Touch screen
You can use the menus and functions of MP3 player by touching the
LCD.

FM Reception
With auto frequency selection feature, you can conveniently listen to
the FM radio broadcasting.

Voice Recording
With the built-in microphone, you can record your voice and FM radio
broadcasting anywhere. 

Photo Viewer
Store and display photos on the vivid display for entertaining slide
shows.

File Format Flexibility
- Music: MP3, OGG, WMA, WAV, ASF
- Video: LG AVI (The player can be only played the video files down-

loaded via LG Media Center.), LG WMV
- Photo: JPG, BMP
- Text: TXT

Media Device(MTP) Mode / Removable Disk(MSC)
Mode
What is the Media Device(MTP) mode?
The MTP stands for the Media Transfer Protocol. It applies the latest
technology defined by Microsoft to support multimedia devices.
- Windows XP / SP1 or higher OS, and Windows Media Player 10.
- To use the MSC mode, select the MSC mode in the PC Connection

Setting menu.
- If the Windows OS does not support the MTP, the player will function

in the MSC mode although the player is set in the MTP mode (Select
the MSC mode for the USB in the setup menu for Windows 98 SE/
ME).

What is the Removable Disk(MSC) mode?
The MSC stands for the Mass Storage Class. The device in MSC
mode functions like a portable memory.

Converting video file
MP3 player can be only played the video files converted via LG Media
Center.
For details about conversion, see the Help menu [Converting video
file] on LG Media Center.

PC Connection Setting
Media Device(MTP) Mode
You should download music files via LG Media Center or Windows
Media Player 10 or higher.
You should download video, photo, and text files via LG Media Center.
You can copy data files to the Data folder. (You can’t see the data
folder in your MP3 player.)

Removable Disk(MSC) Mode
You can copy the Media file to the Removal Disc. (But you should
download video files via LG Media Center.)

Package  contents

- The images inserted herein are examples to make users understand
the more easily and may be little bit different from the real product.

- The contents of the product are subject to change without prior no-
tice for functional improvement.

V50 USB cable 

Software CD Earphones Quick Setup Guide
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* Precautions in using the touch screen

�� Do not tap on the touch screen with your fingers unclean or gloves on. 
- Otherwise, the selected function may not operate in any way. Use it with bare hands lightly. 

�� Do not press the touch screen hard to make it work. 
- If you apply too much strength, it can damage the sensor of the touch screen.

�� Touch the point that you want to work in order to operate the function correctly. 
�� Do not touch the screen with sharp objects like pins, or it cause scratches on the screen.  

1

2

3

4

5

6

1 Display screen(*Touch Screen)

2 Microphone hole/RESET hole

3 • Power on/off  

• Hold switch ( )

4 Record (REC) button

5 USB port

6 Earphone jack 
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Before installing the operating program
Check the specifications of your PC before using
the Player.

Minimum system requirements
- CD-ROM Drive
- Pentium Ι ΙΙ or higher level CPU / 128MB or larger memory
- 300MB or larger hard disc space, 800 X 600 mode
- Hi-color (16 bit) or higher level video card, Sound card

Operating environment
- The MTP mode is applied to the PC equipped with Windows XP

(SP1) or higher-version OS or the Windows Media Player 10/11. 
To the lower-version OS, the MSC mode is applied.

Windows Media Player 10/11
- You can download the file using Synchronize with Windows Media

Player 10/11 menu.
- For more information, see the Help menu of Windows Media Player

10/11.

LG Media Center
- Windows 2000/XP/Vista
- Windows Media Player 10/11/ Internet Explorer 6.0
- Windows Media Player or Internet Explorer will be

automatically installed during installation of the LG Media Center.
Internet connection must be connected in order to install Internet
Explorer.

About LG Media Center
The LG Media Center program is an integrated data
management program developed for users to more
conveniently use the MP3 player.

Features of the LG Media Center

You can efficiently manage music, video, and photo files through the
Media Library rule and download them to the MP3 player.

Installing LG Media Center
1 Insert the operation program CD into the CD-ROM.

2 Select [LG Media Center].

3 Read the License Agreement. Select the check box and click [Next].

4 Select the installation path and click [Next].
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5 Click [Install] to start installation.

6 After finishing the installation, click [Finish].

- You can install CODEC if it is not installed on PC.

7 Click [Start] k [All Programs] k [LG Media Center] to start the
program.

Note
- During installation of the LG Media Center, you can install the Win-
dows Media Player and the Internet Explorer for an operating envi-
ronment.

- The pop up image may be different depending on the OS of PC. 

Installation of the Adobe Acrobat
Reader
1 Insert the operation program CD into the CD-ROM.

2 Select [Adobe Acrobat Reader].

3 Follow the displayed instructions.

View the manual
1 Insert the operation program CD into the CD-ROM.

2 Select [Manual].

3 You can see the manual.

Note
You must install the Adobe Acrobat Reader to read the manual.
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To connect the USB cable
1 Connect one end of the USB cable to the USB port of the PC and

the other to the USB port of the player.

- Check whether both ends are correctly plugged in.

2 If the USB device is normally recognized after the cable is con-
nected, the following will be displayed.

- The software version is displayed on screen.

3 In case of a correct connection, an icon will be displayed on the
task bar of the PC.

- The icon shapes on the task bar may differ depending on the OS of the
PC.

Note
- In case you connect the device to PC with an extended usb cable or
non-certified usb hub, it may not operate. 

To disconnect the USB Cable
Media Device(MTP) mode
Disconnect the USB cable from the PC after checking whether a file is
transferring.
If the file is transferring, disconnect it after the transfer is completed.

Removable Disk(MSC) mode
This feature is to safely remove MP3 player from the PC after upload-
ing or downloading the files.

1 Double-click on the Remove Hardware icon on the task bar of
the PC.

2 Click [Stop] when the window appears.

3 Click [OK].

4 After a message that the large-capacity USB storage can be safely
removed is displayed, remove MP3 player from the PC.

- If the USB cable is disconnected while storing or deleting the file, the
data may get lost.

USB Connected
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To download files - MTP mode
MP3 player will be recognized as a mobile device, not a mass stor-
age, and will interwork with the Windows Media Player 10/11.

1 Connect one end of the USB cable to the USB port of the PC and
the other to the USB port of MP3 player.

- Check whether both ends of the cable are correctly plugged in.

2 The window “MTP Media Player” appears in the PC.

1) a. “Synchronize media files to this device” k “OK”

b. “Manual” k “Finish”

c. Drag the synchronizing files to the left window.

d. Click “Start Sync”.
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2) a. “Take no action” k “OK”

b. Click “LGE MTP Player V50”.

- Data folder: You can download or upload all data files.
- Media folder: You can download only the file that Windows Media

Player 10 supports.

3 Drag the file to copy to the portable media drive.

Note
- When you cannot check the downloaded files on Media folder,

download it to the Data folder again.
- When you connect the device with Windows Media Player 11 or

higher version, you can download files directly to the Internal Stor-
age. That is, lower folders below the device are not separated to
Data and Media on Window Media Player 11 or higher. 

To download files - MSC mode
1 Check whether the device is connected through the MSC mode.

- [Settings] of Home Menu  k [General] k 

[PC Connection Setting] k Removable Disk (MSC)

2 Connect one end of the USB cable to the USB port of the PC and
the other to the USB port of MP3 player.

- Check whether both ends of the cable are correctly plugged in.

3 Check whether a new drive has been added in the Windows Ex-
plorer in the PC.
- The drive name may differ depending on the OS.

4 Drag the file to copy to the removable disc drive.

- Disconnecting the USB cable while the file is being copied may cause
malfunction of MP3 player.

- MP3 player will be charged when connected to the PC through the
USB cable.

- Download video files from LG Media Center.

- Download the JANUS DRM-applied files through the
Windows Media Player 10 or higher, or LG Media Center (MTP Mode
only)

- Download X-Sync DRM-applied files through the LG Media Center.

Data
Media
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To download files - LG Media Center
You can download from MP3 player the files you want via LG Media
Center.
For details, see the Help menu on LG Media Center.

- You can check the downloaded files in the Music, Video, Photo, or
Document folder.

- OGG files only are supported in MSC mode.

1 Connect one end of the USB cable to the USB port of the PC and
the other to the USB port of MP3 player.

- Check whether both ends of the cable are correctly plugged in.

2 Execute the LG Media Center and then click [Add Library]. 

3 [Add file/folder] k Selecting the downing file (Ex: Music file) k
[Apply] k [Ok].

4 [Music] k [Send to Device]

5 Drag the files to the [Send to Device]. 

- Or press on the bottom of the LG Media Center, you can
send the file into the player.
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MP3 player can only play the video files downloaded via LG Media
Center.
For details about download, see the Help menu [Converting video file]
on LG Media Center.

1 Execute the LG Media Center. 

2 Selecting [Tools] k [Advanced Tools] k [Convert Format].

- Or press  on the bottom of the LG Media Center, you can
also activate the converting format program.  

3 In case that the converting codec is not installed or the latest ver-
sion, the pop-up window appears as below.  
Click [Ok].

4 Install the latest updated version.

5 Click [Ok]. 

6 Click [Add] to select a video file you want to convert.

7 Check the video file and then select conversion options.

8 Click [Start], the selected video file start converting.

- After converting, check the video file where the file is .

- For details, see the Help menu on LG Media Center.
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AC adapter(Not supplied)
Charge the MP3 player with an AC adapter(Not supplied).
1 Connect the AC adapter to the AC outlet.
2 Connect the USB cable of AC adapter to the USB port of MP3

player.

- On the display of MP3 player, the charging status will be displayed
as follows: (Charging time: 3 hours)

Note
- Do not disconnect AC Adapter before booting of MP3 player is com-

pleted. The data may get lost.
- Use the confirmed AC adapter when you charge the MP3 player, oth-

erwise the MP3 player may malfunction.
- Do not charge MP3 player for longer than 12 hours. Overcharge and

overdischarge may shorten the battery life.
- If you transfer files on charging, the charging time will be extended.
- Charge the battery in a place with a normal temperature.

USB cable
MP3 player will be also automatically charged when connecting
the PC and MP3 player with USB cable.
- On the display of MP3 player, the charging status will be displayed

as follows: (Charging time : More than 4 hours)

Note
- MP3 player may completely discharged first time you purchase the

product. Charge the battery first.
- Charging time may vary according to PC system requirements or op-

erating environment. If your PC is suspended, MP3 player is not
charged.

- Do not charge MP3 player for longer than 12 hours. Overcharge and
overdischarge may shorten the battery life.

- After checking  the state of a remaining battery of note book, connect
the USB cable and charge it.

- Do not charge it when the remaining battery of the note book is not
enough.

- If you transfer files on charging, the charging time will be extended.
- Charge the battery in a place with a normal temperature.

USB Connected

Firmware V50 S1.00EN

Charging status

2

1

Power-on status

Power-off status

Charging

Charging status
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Turning on/off the power
Turning on the power

Push the power on/off switch in the direction of the until MP3 player
is turned on.
- Downloading files in MSC mode may take time for rebuilding depending

on the number of files.

Turning off the power
Push the power on/off switch in the direction of the until MP3 player
is turned off.

Lock feature
This feature locks MP3 player to prevent it from operating when
you accidentally press a button.

1 Push the power on/off switch in the direction of the to lock MP3
player.

- Upon locked status, will be displayed on LCD. 

Upon pressing of each button, will appear for two seconds and dis-
appear.

2 Push the power on/off switch in the opposite direction of the but-
ton to unlock the device.

Reset feature
This feature is to reset the player when the MP3 player does not
operate normally.

1 Press the RESET hole with pointed object like a sharp pencil when
the player is suspended. 

Locked

Locked

Power On Power Off

RESET hole
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Home menu screen
You can operate various features by using the Home menu.

* Home menu screen varies according to product models 
(FM radio reception is optional.)

1 Music : Moves to the music mode.

2 Movie : Moves to the video mode.

3 Photo : Moves to the image mode.

4 Radio : Receives and records FM broadcasting.
(FM radio reception is optional.)

5 Text : Moves to the text mode.

6 All Files : Displays the playable total list.

7 Game : Moves to the game mode.

8 Settings : Sets the operating environment of the player.

Note

General operations of Home menu
1 Turn the MP3 player on.

- The home menu appears on LCD.

2 Press the icon of a desired menu.

3 Press the icon of selected menu.

4 Press the desired menu to move to the second level and then press
the selected menu to execute the menu.

Note
- Press to return to the previous menu during operation.

- Press and move to the right downward direction to return to the
home menu during operation.

- Press and move to the left upward direction to return to the pre-
vious menu.

Icon of the 
selected menu

Contents of the 
selected menu

cc

bb

aa

dd

gg

hh

ee

ff

The section marked as above is specified as “middle part” in
this manual.

Middle part applied in
rectangular screen
view(music/photo/text
mode)

Middle part applied in
horizontal screen view
(Movie mode)

Applied in 
volume control
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Music playing screen

1 Moves to the previous menu or home menu.

2 Playback time

3 Bookmark display

4 Play mode display

5 Playing time bar

6 Remaining time

7 Music information display 
(Album, Artist, Title)

8 Image/Lyrics

9 Moves to the EZ menu

10 Control box (Play/ Pause/Volume/Skip/A-B repeat/FF/RW)

11 Battery status

Tip
- The playback image is displayed as an album art of a currently playing

music file when you download the music file via Windows Media Player
10/11. 

- Supported album art - ID3 Tag

Music menu

Last Played File
Plays the last played music file.

Random play all
Plays the music file randomly.
- When you set [Random play all] during operation, the play mode is

changed to [Random all].

Playlist
• My Playlist

You can select and manage your own playlist.

• PC Playlist :
The playlist created in the WMP(Windows Media Player 10 or higher)
or the LG Media Center can be automatically displayed on the MP3
player through the Auto Sync mode.
- When the playlist and corresponding files are unchecked in the

Auto Sync mode, music will be deleted in the MP3 player. It is rec-
ommended to keep all Music files always checked.

All music
Displays the total music.

Artist
Displays the music by artist.

Album
Displays the music by album.

Genre
Displays music by genre.

Recorded File
Plays the radio recording file (Option by models) or voice recording
file.

Note
- The selected file is played when you select the desired file.

- Select a file you want and press , you can delete it.

Edit
Delete All Deletes all files in my playlist.

Adds the desired file in my playlist.Add Music

1

2

4

8

7

9

3

5

11

6

10
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Playing music files
1 Select of the home menu.

2 Select the desired menu and then press a music file you want to
play.
- If you select the [Last Played File] menu, the last played music file will

be played at once.

Pause
1 Press the middle part of LCD during playback. 

2 Press the middle part of LCD again to resume playback.

Using the control box
1 Press during playback.

- The control box appears on LCD.

2 Press to pause.

- The appears on LCD.

3 Press to resume playback.

4 Press or other space to remove the control box.
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Playing the previous or next file
Drag the middle part of LCD in the direction of the left/right  during
playback. 

- If you drag the LCD from right to left after five seconds of playing
time, the current file will be played from the beginning.

- If you drag the LCD from right to left within five seconds of playing
time, the previous file will be played from the beginning.

Using the control box

1 Press during playback.
- The control box appears on LCD.

2 Press / button to play the previous or next file.

- If you press after five seconds of playing time, the current file will
be played from the beginning.

- If you press within five seconds of playing time, the previous file will
be played from the beginning.

Speed search
Drag the LCD during playback and then press and hold the LCD.

Using the control box
1 Press during playback.

- The control box appears on LCD.

2 Press and hold / button for two seconds during playback. And
then release at a point you want.

Release at a point you want.

Release at a point you want.
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Playing from a specific point
1 Press the playing time bar to play from a specific point you want

during playback.
- The control box appears on LCD.

2 Press / / / .

- : Moves to the point of playing time before 1 minute.
If the playing time is less than 1 minute, the current file moves to
the beginning point.

- : Moves to the point of playing time before 5 seconds.

- : Moves to the point of playing time after 5 seconds.

- : Moves to the point of playing time after 1 minute.
If the remaining time is less than 1 minute, the current file moves
to the beginning point of next music.

A-B section repeat

This feature can only set the current playing music.

1 Press during playback.
- The control box appears on LCD.

2 To set the starting point during playback, press .

- “A” icon appears on LCD.

3 To select the ending point, press again. Then, the Repeat fea-
ture will be set.

- “B” icon appears on LCD.

4 To cancel Repeat feature, press again.

- “A” and “B” icons disappear on LCD.

Volume control
Touch the screen. Then keep pressing and turn the point you press on
LCD clockwise/counterclockwise during playback.

Volume up

Volume down

Using the control box
1 Press during playback.

- The control box appears on LCD.

2 Press or to control the volume.+-

A-B

A-B

A-B

24

12
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EZ menu 
You can set the desired function or switch to other modes using the
EZ menu.
Press to select the EZ menu during playback.

Bookmark
You can start playback from memorized point.
• Set : Sets the bookmark.
• Move : Executes the bookmark.
• Cancel : Cancels the bookmark.

Simultaneous View
• Photo : You can view the photo while listening to the 

music simultaneously.
[Photo] k [ (Moving to EZ menu of the photo] k
[Music] k [Cancel]/[Play Previous]/[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays the previous music.
- [Play Next] : Plays the next music.
- [Back] : Moves to the music mode.

• Text : You can view the text while listening to the music simultane-
ously.

[Text] k [ (Moving to EZ menu of the text] k [Music]
k [Cancel]/[Play Previous]/[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays the previous music.
- [Play Next] : Plays the next music.
- [Back] : Moves to the music mode.

Create My Playlist/Delete My Playlist
Creates or deletes files in my playlist.

Play Mode
• Repeat One

Plays the current file repeatedly.
• Play All

Plays all music within the selected folder in order.
• Repeat All

Plays all music within the selected folder repeatedly.
• Random All

Plays all music within the selected folder randomly.
• Random Repeat All

Repeats all music within the selected folder randomly.

Sound Effect
You can set sound effect by selecting EQ or 3D Sound. 
• EQ: AUTOEQ, NORMAL, POP, ROCK, R&B/SOUL, HIPHOP/RAP,

JAZZ, CLASSICAL, DANCE, LIVE, USER EQ
• 3D Sound: Off, CLEAR, 3D EXPANDER, STADIUM, CONCERT

HALL, CLUB, ROOM, BASS BOOST, X-LIVE 

View Lyrics
• Lyrics
You can show the lyrics if a music file supports the lyrics.
• On : Sets the lyrics view.
• Off : Cancels the setting of lyrics view.

• Lyrics Color
You can set lyrics color when you set [Lyrics] to On.
You can select it among Default, Blue, Red, White, Gray, Yellow, and
Green.
- Default color is <Default>

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(Bitrate, File Size, Sampling, Codec, Setting)
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Movie playing screen

1 Moves to the EZ menu.

2 Moves to the control box. 
(Play/ Pause/ Volume/ Skip)

3 Battery status

4 Title of the video file

5 Moves to the previous menu or home menu.

6 Bookmark display

7 Playback time

8 Playing time bar

9 Remaining time

10 Playing screen

Playing movie files
MP3 player can only play the video files downloaded via LG
Media Center. For details about download, see the Help menu
[Converting  video file] on LG Media Center.

1 Select of the home menu.

2 Select the desired file.
- The list is displayed on LCD.
- If there is no list, “No file” appears on LCD.

3 Press the desired file.
- The movie file is played.
- The movie file will be displayed on the horizontal screen.

Note

- Select a file you want and press , you can delete it.

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

987

10

1

2
3
4
5
6

OVER THE RAINBOW : Garden of Useful Publishing SYStem 
00:0041 -00:02:23
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Pause
1 Press twice the middle part of LCD during playback. 

2 Press twice the middle part of LCD again to resume playback.

Using the control box

1 Press the LCD during playback.

2 Press .
- The control box appears on LCD.

3 Press to pause.

- The appears on LCD.

4 Press to resume playback.

5 Press or other space to remove the control box.

Playing the previous or next file

1 Press the LCD during playback.
2 Drag the middle part of LCD in the direction of the left/right during

playback.  

- If you drag the LCD from right to left after five seconds of playing
time, the current file will be played from the beginning.

- If you drag the LCD from right to left within five seconds of playing
time, the previous file will be played from the beginning.

Using the control box

1 Press the LCD during playback.

2 Press .
- The control box appears on LCD.

3 Press / to play the previous or next file.

- If you press after five seconds of playing time, the current file will
be played from the beginning.

- If you press within five seconds of playing time, the previous file will
be played from the beginning

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23 00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

Movie 3 : Flower of Useful Publishing SYSte
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23 00:0041 -00:02:23

+

-

+

-
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Speed search
1 Press the LCD during playback.
2 Drag the middle part of LCD in the direction of the left/right  during

playback and then press and hold the LCD.

Using the control box

1 Press during playback.
- The control box appears on LCD.

2 Press and hold / button for two seconds during playback. And
then release at a point you want.

Playing from a specific point
1 Press the LCD during playback.
2 Press the playing time bar to play from a specific point you want

during playback.
- The control box appears on LCD.

3 Press / / / .

- : Moves to the point of playing time before 1 minute.
If the playing time is less than 1 minute, the current file moves to

the beginning point.

- : Moves to the point of playing time before 5 seconds.

- : Moves to the point of playing time after 5 seconds.

- : Moves to the point of playing time after 1 minute.
If the remaining time is less than 1 minute,the current file moves to
the beginning point of next music.

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

Movie 3 : Flower of Useful Publishing SYSte
00:0041 -00:02:23

Press and hold. Press and hold.

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23

Release at a point
you want.

Release at a point
you want.

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23 00:0041 -00:02:23

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

+

-
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Volume control
Touch the screen. Then keep pressing and turn the point you press on
LCD clockwise/counterclockwise during playback.

Volume up Volume down

Using the control box

1 Press the LCD during playback.

2 Press .
- The control box appears on LCD.

3 Press or to control the volume.

EZ menu 
You can set the desired function or switch to other modes using the
EZ menu.

Touch the screen.

Press to select the EZ menu during playback.

Bookmark
You can move to the point you set while playing the video.
• Set

Sets the bookmark.
• Move

Executes the bookmark.
• Cancel

Cancels the bookmark.

Search Speed
You can set the playing speed of movies files.
• 1 time

Plays at an original speed.
• 2 times

Plays at 2 times speed.
• 3 times

Plays at 3 times speed.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(File Name, Full Time , File Size, Setting)

+-

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

Movie 3 : Flower of Useful Publishing SYSte
00:0041 -00:02:23

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

Movie 3 : Flower of Useful Publishing SYSte
00:0041 -00:02:23

1426

Movie 3 : Flower of Useful Publishing SYSte
00:0041 -00:02:23 00:0041 -00:02:23

00:0041 -00:02:23

Brightness
Delete file 
View Information

2/5

Bookmark

Search Speed 
+

-
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Photo viewing screen

1 Moves to the previous menu or home menu.

2 Enlarging/ Reducing the photo size

3 Music/ Radio mode display

4 File name

5 Photo screen

6 Moves to the EZ menu.

7 Moves to the control box. (Slide show/ Volume/ Skip)

8 Battery status

Viewing photo files
1 Select of the home menu.

2 Press the desired file.
- The list is displayed on LCD.
- If there is no list, “No file” appears on LCD.

3 Press the desired file.
- The photo file appears on LCD.

Note
- MP3 player may not be played a black-and-white photo or large-ca-

pacity file.

- Select a file you want and press , you can delete it.
- Large-sized photos may not be opened or played.

Enlarging/ Reducing the photo size
1 Press to enlarge the photo size while viewing a photo. 
2 Press it again to reduce the photo size. 

- Horizontal size is longer than vertical size of a photo file will be dis-
played on the horizontal screen.

1

2
4

6

5

78

3

The player is not supported some JPEG Progressive
files. Download through the LG Media Center
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Setting the slide show
1 Press the middle part of LCD when a photo file is 

displayed.

2 Press the middle part of LCD again to pause.

Using the control box

1 Press during playback.
- The control box appears on LCD.

2 Press to set the slide show.

- The appears on LCD.

3 Press to pause.

- The appears on LCD.

4 Press or other space to remove the control box.

Viewing the previous or next file
Drag the middle part of LCD in the direction of the left/right during
playback.  

Using the control box

1 Press during playback.
- The control box appears on LCD.

2 Press / button to view the previous or next photo.
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Viewing photos while listening to
music/radio

Press or (you previously set on the DUAL of EZ menu) to lis-
ten to music or radio while enjoying photos. Refer to DUAL of the page

30 for the method on how to set music/radio mode in detail. 

Viewing photos while listening to music

Press . Then the control box is displayed as shown below. 

- : You can start playing music.

- :  You can pause playback. 

- / : 1. Short key: Press this button briefly, you can play the
previous or next file.            

2. Long key: Press and hold this button, you can search a
desired music file. 

Viewing photos while listening to radio

Press . Then the control box is displayed as shown below.

The mode is displayed as you previously on radio mode. 

- : You can start radio play.

- :  You can pause playback. 

- / (In Non-Preset mode): Press this button, you can find avail-
able radio station.             

- / (In Preset mode): Press this button, you can listen to the

previous/next preset channel.  

Volume control
When you listen to music or radio while viewing the photo file, control
the volume. 

Touch the screen. Then keep pressing and turn the point you press on
LCD clockwise/counterclockwise during playback.

Volume up

Volume down

Using the control box

1 When you listen to music or radio while viewing the photo file, press

.
- The control box appears on LCD.

- The mode is displayed as you previously on radio mode.

2 Press the or button to control the volume.+-

Ch +Ch +Ch - Ch +Ch -

Mode Mode

Ch +Ch - Ch +Ch -

Mode Mode

Mode ModeMode Mode

12

24

Non-Preset mode Preset mode
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EZ menu 

You can set the desired function or switch to other modes using the
EZ menu.

Press to select the EZ menu while viewing the photo.

DUAL
You can listen to music or radio while viewing the photo file. 
• Music : You can listen to music while viewing the photo file.

[Music] k [ (Moving to EZ menu of the photo] k
[Music] k [Cancel]/[Play Previous]/[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays previous music.
- [Play Next] : Plays next music.
- [Back] : Moves to the music mode.

• Radio : You can listen to radio while viewing the photo file.
[Radio] k [ (Moving to EZ menu of the photo] k
[Radio] k [Cancel]/[Previous Channel]/[Next
Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

Slide Show
You can set the slide show to On/Off.
• On

Turns on the slide show.
• Off

Turns off the slide show.

Slide Interval
You can set the slide show interval to [2 sec], [3 sec], [4 sec],or [5
sec].

View 4 slides
You can show 4 slides on one screen.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Background Setting
You can set the photo you are viewing currently into
Music/Radio/Menu/Screen saver background. 
• Music Background

You can set the currently viewing photo file to music background.
• Radio Background

You can set the currently viewing photo file to Radio background.
• Menu background

You can set the currently viewing photo file to each menu back-
ground.

• Screen saver Background
You can set the currently viewing photo file to screen saver back-
ground.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(File Name, File Kind, File Size, Setting)
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FM radio reception screen 

1 Moves to the previous menu or home menu.

2 FM radio frequency display bar

3 FM radio frequency display

4 Moves to the EZ menu.

5 Moves to the control box (Play/ Mute/ Volume/ Mode)

6 Battery status

1 Moves to the previous menu or home menu.

2 Channel no(Channel mode)

3 FM radio frequency display

4 Moves to the EZ menu.

5 Moves to the control box (Play/ Mute/ Volume/ Mode)

6 Battery status

Setting preset channels
1 Select of the home menu.

2 If you want to store the channel press [Yes], otherwise press [No].
- You can save maximum 20 channels and existing channels will be

deleted.
- In an area with weak reception, the detected channels may be less

than 20.

3 The FM radio broadcasting is received.

Listening to the FM radio
1 Select of the home menu.

- The stored channel list is displayed on LCD when you previously set
the mode to preset mode in Radio mode. 

2 You can listen to the FM radio.

Note
- The mode is displayed as you previously on the radio mode. 
- Press once to check the channel list on the preset mode.

Preset mode

1

2

4

3

6 5

1

2

4

3

6 5

Non-Preset Mode

Preset Mode

Non-Preset Mode
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Muting sound
1 Press the middle part of LCD while listening to the radio. 

2 Press the middle part of LCD again to listen to the radio.

Using the control box

1 Press while listening to the radio.
- The control box appears on LCD.

2 Press to set muting.

- The appears on LCD.

3 Press to listen to the radio.

4 Press or other space to remove the control box.

Searching FM radio stations
Manual Search
Drag the middle part of LCD in the direction of the left/right while lis-
tening to the radio. 

Using the control box
Press while listening to the radio.

- The control box appears on LCD.

- Press on LCD until the and appear on Non-Preset Mode.

- Press on LCD until the and appear on Preset Mode.Ch +Ch +Ch - Ch +Ch -

Mode Mode

Ch +Ch - Ch +Ch -

Mode Mode

Mode Mode
Mode ModeMode Mode

Mode Mode

Non-Preset Mode (Decreases/increases step by step.)

Preset Mode (Decreases/increases channel by channel.)

Non-Preset Mode

Preset Mode
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Automatic Search
Drag the middle part of LCD in the direction of the left/right during re-
ception and then press and hold the LCD.

Using the control box
1 Press while listening to the radio.

- The control box appears on LCD.

- Press on LCD until the and appear on LCD.

2 Press , .
- Press any button or the frequency bar during automatic search to can-

cel it.
- Reception may be weak in some areas.
- As earphones function as antennas, only LG Electronics' ear-

phones guarantees the reception quality.

Volume control
Keep pressing and turn the point you press on LCD clockwise/coun-
terclockwise while listening to the radio. 

Volume up

Volume down

Using the control box
1 Press during while listening to the music/radio.

- The control box appears on LCD.

2 Press the or button to control the volume.+-

Mode ModeMode Mode

Mode ModeMode Mode

Mode Mode

12

24

Press the LCD for about 2 seconds.

Press the LCD for about 2 seconds.
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EZ menu 
You can set the desired function or switch to other modes using the
EZ menu.

Press to select the EZ menu while listening to the radio.

Simultaneous View
• Photo : You can view the photo while listening to the radio simulta-

neously.
[Photo] k [ (Moving to EZ menu of the photo)] k
[Radio] k [Cancel]/[Previous Channel]/[Next
Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

• Text : You can view the text while listening to the radio simultane-
ously.

[Text] k [ (Moving to EZ menu of the text)] k [Radio]
k [Cancel]/[Previous Channel]/ [Next Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous  channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

Delete Channel/Save Channel
Deletes or stores a radio channel.

Channel Search
You can store the FM radio channel automatically.
- The previous memorized channel will be deleted.
- Press [Cancel] to stop while searching the channel.

Radio Mode
You can select the channel mode or frequency mode.

• Preset Mode
You can set the FM radio broadcasting to channel mode.

• Non-Preset Mode
You can set the FM radio broadcasting to frequency mode.

View Information
Displays the information of the receiving radio.
(Frequency, Reserved REC Interval, Reserved REC Time , Reserved
frequency, Setting)
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Text viewing screen 

1 Moves to the previous menu or home menu.

2 Bookmark display

3 Activates/Deactivates TTS(Text To Speech) 

4 Current page/Total page

5 Music/ Radio display

6 Text display

7 Moves to the EZ menu

8 Moves to the control box(Auto skip/Volume/Skip)

9 Battery status

Viewing text files
1 Select of the home menu.

2 Select the desired list.
- The list is displayed on LCD.
- If there is no list, “No file” appears on LCD.

3 Press the desired file.
- The text file appears on LCD.

Note

- Select a file you want and press , you can delete it.

1 7

6

9

53

8

4

2
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Viewing the previous or next page
Drag the middle part of LCD in the direction of the left/right during
playback.  

Using the skip icon 
1 Touch the left or right end of the screen while you view texts.

2 / is displayed and the player moves to the previous or next
page.

Using the control box
1 Press during playback.

- The control box appears on LCD.

2 Press / to view the previous or next page.

Skipping pages automatically
1 Press the middle part of LCD when a text file is displayed.

2 Press the middle part of LCD again to pause.

Speed search
Drag the LCD during playback and then press and hold the LCD.

Using the control box
1 Press during playback.

- The control box appears on LCD.

2 Press and hold / and release it at parts you want.

Release at a point you want.

Release at a point you want.
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Viewing texts while listening to
music/radio

Press or (you previously set on the DUAL of EZ menu) to lis-
ten to music or radio while reading texts. Refer to DUAL of the page

38 for the method on how to set music/radio mode in detail. 

Viewing texts while listening to music

Press . Then the control box is displayed as shown below. 

- : You can start playing music.

- :  You can pause playback. 

- / : 1. Short key: Press this button briefly, you can play the
previous or next file.            

2. Long key: Press and hold this button, you can search a
desired music file. 

Viewing texts while listening to radio

Press . Then the control box is displayed as shown below.

The mode is displayed as you previously on radio mode. 

- : You can start radio play.

- :  You can pause playback. 

- / (In Non-Preset mode): Press this button, you can find avail-
able radio station.             

- / (In Preset mode): Press this button, you can listen to the

previous/next preset channel.  

Volume control
Keep pressing and turn the point you press on LCD clockwise/coun-
terclockwise while listening to the music/radio. 

Volume up

Volume down

Using the control box
1 Press during while listening to the music/radio.

- The control box appears on LCD.

2 Press the or button to control the volume.

Using TTS function
With TTS(Text To Speech) function, you can convert language text into
speech and listen to it. This function is supported only when you set
Language to English. 

1 Press to convert text files into speech. 

2 Press it again to stop. 
- Or press the center of the screen, you can stop it. 

Note
- After the currently viewing page is finished converting, the nex page

starts converting. 
- When you activate TTS function, Auto skip will automatically stop.
- When you activate TTS function while listening to music or radio,

music/radio playback will stop. 
- If you do not set the language to English, “Not supported” is displayed

on screen in the currently set language. 

+-

Ch +Ch +Ch - Ch +Ch -

Mode Mode

Ch +Ch - Ch +Ch -

Mode Mode

Mode ModeMode Mode

Non-Preset mode Preset mode

12

24
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EZ menu 

You can set the desired function or switch to other modes using the
EZ menu.

Press to select the EZ menu while viewing the text.

DUAL
• Music : You can listen to music while viewing the text simultane-

ously.
[Music] k [ (Moving to EZ menu of the text] k [Music]
k [Cancel]/[Play Previous]/[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays the previous music.
- [Play Next] : Plays the next music.
- [Back] : Moves to the music mode.

• Radio : You can listen to the radio while viewing the text simultane-
ously.
[Radio] k [ (Moving to EZ menu of the text] k [Radio]
k [Cancel]/[Previous Channel]/[Next Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

Bookmark
You can move to the point you set while playing the text.
• Set

Sets the bookmark.
• Move

Executes the bookmark.
• Cancel

Cancels the bookmark.

Auto Skip
Sets an interval for auto text skipping.
You can select [Off] or a value from 10 sec to 20 sec.

Find Page
You can move to the desired page.

Font color
You can set the text color among White, Gray, Green, Blue, Yellow,
and Red. 
The default color is White.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(File Name, File Size, Page, Setting)
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Recording screen 

1 Moves to the previous menu or home menu.

2 Record display (Start/ Pause/ Continue)

3 Title of the recording file

4 Recording standby/ Recording time

5 Recording end

6 Moves to the EZ menu.

7 Battery status

Recording 
1 Press REC button more than 1 second to record while listening to

the radio or in other menus.
- In FM recording: The recording time will be displayed and the recording

will start.
- In voice recording: 1) The player turns into stand-by mode for recording.

2) Press [Start] to voice recording. 
2 Press [Pause] to pause.
3 Press [End] to end the recording.

- Select [Continue] to resume recording.
- The recorded files will be stored under Record folder as a file

named F071116_xxxx in FM recording or V071116_xxxx in voice
recording(ModeYear Month Date_Order)

4 Refer to [Recorded file] on page 18 to play prerecorded files.

Note
If the remaining memory space is less than 4MB, the player may not
be recorded.

EZ Menu 
You can set the desired function or switch to other modes using the
EZ menu.

Press to select the EZ menu while recording radio/voice.

Recording Quality
You can set the quality of the recorded file.
- You can set [96kbps], [128kbps], or [192kbps].

VAD
In case of voice recording, recording will automatically stop upon mute
sound and will resume upon reception of the voice signal.
- You can select [On] or [Off].

View Information
Displays the information of the recording file.
(Quality, Vad, Setting)

1 6

7

5

4

2

3
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All Files
1 Select of the home menu.

2 You can confirm and play the playable list on each mode.

Note

- Select a file/folder you want and press , you can delete it.

Game
1 Select the icon of the home menu.

[Dynamic HEADING]
Heading for both side of balls that mission will be succeed.
Do not pile up the over 5 balls in given time. 
Many kinds of items will appear.

[PIKKO] 
See the tail of wind, put PIKKO by pressing PIKKO the basket. 
Chances are just 5 times! You can get the lost chances in every 5
success by one. High score is the most succeed chances.

[Champion Batter] 
To gain the mission point of each level, the batter should get to first
base.
If you use a pinch hitter of each level, the mission will be easily
completed.
Be careful with various ways of pitch and 11 special pitches.

[Salad World] 
To escape vegetables, place more than 3 same vegetables, in a line
(up, down, right and right) Use magnetic and fog effect items. Fog -
the effect will be going on for 6 second. If you click one salad during
fog effect, all same vegetables can escape.

[Burning Skewered Food] 
Complete skewered food according to order box by operating but-
ton related to materials.

2 Press the desired game file.
- For details, see the [HELP] menu.
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Select the icon of the home menu to enter Settings
menu.

Music
Play Mode
• Repeat One

Plays the current file repeatedly.
• Play All

Plays all music within the selected folder in order.
• Repeat All

Plays all music within the selected folder repeatedly.
• Random All

Plays all music within the selected folder randomly.
• Random Repeat All

Repeats all music within the selected folder randomly.

Music Speed
You can set the playing speed of MP3 files.

- You can select [0.3 times], [0.5 times], [1 time], [1.5 times], and [2
times].

- The default value is [1 time].
- MP3 files sampled at less than 32KHz can support only [1 time].

Sound Effect
- EQ: You can set the sound effect.

(AUTO EQ, NORMAL, POP, ROCK, R&B/SOUL, HIPHOP/RAP,
JAZZ, CLASSICAL, DANCE, LIVE, USER EQ)

- 3D Sound: You can experience 3D sound effects.
(Off, CLEAR, 3D EXPANDER, STADIUM, CONCERT HALL, CLUB,
ROOM, BASS BOOST, X-LIVE)

Fade In
You can gradually increase the volume to protect ears.
- You can select [On] or [Off].

Scroll Speed
Sets the speed of the file name and ID3 tag information in the music
playing mode.
- You can select [Off], [0.5 times], [1 time], [2 times], and [3 times].

Search Interval
You can select the slide show interval.
- You can select [3 sec], [5 sec], [10 sec], or [30 sec].

Lyrics
You can show the lyrics if a music file supports the lyrics.
• On : Sets the lyrics view.
• Off : Cancels the setting of lyrics view.

Lyric color
You can set lyrics color when you set [Lyrics] to On.
- You can select it among Default, Blue, Red, White, Gray, Yellow, and

Green.
- Default color is <Default>

Background setting 
You can select the photo file for music background.
• Album Art : Displays the album jacket during playback.
• Album Art

1) The album image saved with a music file is displayed.
- Synchronize the file with album information on Windows Media

player.
2) If a photo file is saved as the same name as that of ID3 Tag

Album of a music file on the same folder, the photo is displayed
as an album art.

3) If a photo file is saved as the same name as that of a music file on
the same folder, the photo is displayed as an album art.

4) The three cases exist simutaneously, an album art is displayed in
the following order [1]-[2]-[3].

• User Image
Displays the user’s desired photo during playback.

• Default Image
Displays the basic photo during playback.

Movie
Search Speed
You can set the playing speed of movies files.
• 1 time : Searches at an original speed.
• 2 times : Searches at 2 times speed.
• 3 times : Searches at 3 times speed.

MXD Engine Effect
You can show a high-definition image of movie files.
- You can select [On] or [Off].

Photo
Slide show
You can set the slide show to On/Off.
• On : Turns on the slide show.
• Off: Turns off the slide show.

Slide Interval
You can set the slide show interval to [2 sec], [3 sec], [4 sec],or [5
sec].

Text
Font Color
You can set the character color in the text mode.
- You can select [White], [Gray], [Green], [Blue], [Yellow], or [Red].

Auto Skip
Sets an interval for auto text skipping.
- You can select [Off] or a value from [10 sec] to [20 sec].

TTS(Text To Speech) Speed
You can set the converted speech speed of languag texts. 
- You can select [X1], [X1.5], [X2].

Radio
Mode
You can set the reception mode.
- You can select [Auto] or [Mono].

Sensitivity Setting
The higher, the more frequency channels.
- You can set [High], [Standard],or [Low].

Region Setting
You can set the reception area.
- You can select [Korea], [Japan] or [Others].

Reserved Recording
You can reserve the FM radio recording.
- You can set the frequency for reserved recording.
- Reserved recording feature is activated only when MP3 player is

turned off.
- You can set only one reserved recording.
- Recording can be made for maximum 23 hours and 59 minutes.

Radio background
You can select the photo file for radio background.
• User Image

Displays the user’s desired photo during playback.
• Default Image

Displays the basic photo during playback.
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Record
Recording Quality
You can set the quality of the recorded file.
- You can set [96kbps], [128kbps], or [192kbps].

VAD
In case of voice recording, recording will automatically stop upon mute
sound and will resume upon reception of the voice signal.
- You can select [On] or [Off].

Time
Sleep Reservation
When the defined time passes, MP3 player will be automatically
turned off.
- You can select [Off], [10 min], [30 min], [1 hr], or [2 hr].
- If you set the turning-off reservation, MP3 player will automatically

store files and be turned off at the reserved time.
- After MP3 player is turned off at the reserved time, the turning-off

reservation will be automatically cancelled.

Time System
You can set the current time in 12/24 hour time system.

Time Setting
You can set the current time.
- You can set years between 2001 and 2099.
- When downloading files synchronized on windows media player in

MTP mode, the time setting of MP3 player will be synchronized with
the one of the PC.

Time zone
You can set a applicable time zone on the player. 

Summer time 
You can set daylight saving time system to this player’s clock system. 
• On : Applies the summer time system to this player and then one

hour is adjusted forward.
• Off: Deactivates the summer time system. 

Note
When moving to other regions or countries, you have to set the Time
zone and summer time system to be compatible there. 

Display Setting
Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Theme Setting
Sets menu type.
- You can select [Icon type] or [List type].

Menu Color
You can set the color of the home menu to [Red]/[Blue].

Screen saver
You can set screen saver to protect the display screen while there’s no
touch on the screen. 
- You can select [On] or [Off].

Menu background 
You can select the photo file for menu background.
• Theme setting 

Displays a theme image you selected among Default theme setting,
Leisure, Animal, Artist, Rhythm, Equalizer, and Animal skin.

• User image
Displays the user’s desired photo during playback.

Screen saver background
You can select the photo file for screen saver background.
• Default image

Displays the basic photo during playback.
• User image

Displays the user’s desired photo during playback.

General
Control Box
You can select the control box.
• On : Displays the control box.
• Off : Cancels the display of control box.

Rebuilding
You can search the downloaded files and upgrade the list.
- You can select [Yes] or [No].
- If you select [Yes], the list will be upgraded. If you select [No], MP3

player will return to the general setting screen.
- As updating the list may take time, check the battery status in ad-

vance.

Initialize Settings
You can initialize the setting of MP3 player.
- You can select [Yes] or [No].
- If you select [Yes], MP3 player is automatically turned off and then

on. 
- If you select [No], MP3 player moves to the previous menu.
System Info
You can check the product information.
- The entire memory space, the used memory space, remaining mem-

ory space, the model name and firmware version are displayed.

Language
You can select the language.
- Korean, English, Portuguese, Russian, Danish, German, Dutch,

French, Hungarian, Italian, Norwegian, Polish, Spanish, Swedish,
Chinese (Traditional), Ukrainian, Finnish, Greek, Turkish 

Power Management
• Auto Display Off

If no button is inputted during the given time, the LCD will be auto-
matically turned off.
- You can select [Off], [5 sec], [10 sec], [30 sec], or [60 sec].

• Auto Power Off
If no button in selected in the standby mode for playing, the screen
will be automatically turned off.
- You can select [Off], [30 sec], [1 min], [5 min], or [10 min].

PC Connection Setting
• Media Device(MTP) Mode

- The MTP applies the latest technology of Microsoft to support the
multimedia devices. It is recognized as a mobile devices and com-
patible with Windows Media Player10.

• Removable Disk(MSC) Mode
- MP3 player will function as a general removable storage in this

mode.

Format
You can delete all data in the memory and initialize the memory.
- You can select [Yes] or [No].
- If you select [Yes], formatting will be made. If you selects [No], MP3

player will return to the general setup screen.
- Back up the data stored in MP3 player before initializing it.
- Deleted data cannot be recovered.

Calibration
You can adjust a focus on LCD.
- Press “+” repeatedly.
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Upgrading firmware automatically
Connect MP3 player to the PC where the LG Media Center is in-
stalled to download a new version of
firmware.

1 Connect one end of the USB cable to the USB port of the PC with
the LG Media Center installed and the other to the USB port of MP3
player.

2 The LG Media Center will compare the firmware versions of MP3
player and the server. If it detects a new firmware version, it asks
you whether to upgrade the version.

3 Click [OK] to copy new firmware to the MP3 player.

4 Upon updating, new version firmware will be copied to the MP3
player.

5 To safely remove the device, remove the USB cable.
(In MSC mode)

6 When "Firmware upgrade?" message is displayed, click the REC.

7 The firmware updating progress bar will be displayed. After the up-
grade is completed, the power will be automatically turned off.
- Wait till the player is automatically restarted.

8 Turn on the MP3 player and check the upgraded 
version of firmware.
- You can check the firmware version in Home Menu [Settings] of

Home Menu  k [General] k [System Info]

Upgrading firmware manually
You can upgrade the firmware for addition and change of fea-
tures of MP3 player and for functional improvement.

1 Check the model number at the company website, and download
the latest version.

- http://www.lge.com k Support k Download k Software
(The contents may differ depending on the website.)

2 Decompress the downloaded files. Then, V50.rom file will be dis-
played.

3 Connect the USB cable to the MP3 player and the PC.

4 Check whether a new drive has been added in the Windows Ex-
plorer in the PC.

- The drive name may differ depending on the OS.

5 Select the V50.Rom, V50VIS.PAC, V50TTS.PAC files and copy it to
the newly added drive.

- In Windows Media Player 10 version:

In MSC mode: Highest root

In MTP mode: Data folder 

- In Windows Media Player higher than 10 version: Internal Storage 

6 To safely remove the device, remove the USB cable.(In MSC mode)

7 When "Firmware upgrade?" message is displayed, click the REC.

8 The firmware updating progress bar will be displayed. After the up-
grade is completed, the power will be 
automatically turned off.

- Wait till the player is automatically restarted.

9 Turn on the MP3 player and check the upgraded version of
firmware. 

- You can check the firmware version in Home Menu [Settings] of
Home Menu  k [General] k [System Info].

V50.rom

V50VIS.PAC

V50TTS.PAC

- Functions only in the Internet-connected PC.
- Back up important data before upgrading, or the data may get lost.

Back up important data before upgrading, or the data may get lost.

PAC file 
22,181KB

ROM file 
16,766KB

PAC file 
25,151KB
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Q :MP3 player will not be turned on.
A : Check whether the battery is remaining.
A : Connect the AC adapter and charge the battery.

Q : The screen is blur.
A : Avoid direct sun rays and adjust the brightness.
A : Check the LCD brightness.

Q : The button does not function.
A : Check whether the Hold feature is active.
A : Check whether you pressed right button.

Refer to the page 7 for using touch screen. 
A : Press the reset hole. Refer to the page 16.

Q : The characters on display look broken.
A : Download the font file from the website and copy it to the Con-

fig folder.
A : The Config folder is displayed only in MSC mode. Change to

the MSC mode (In case of MTP mode, copy the font file to the
data folder).

Q : The noise is severe during listening to the radio, and the re-
ception is poor. 
A : The earphone functions as an antenna. 

Be sure to handle carefully.
A : Slightly change the directions of MP3 player and the ear-

phones.

Q : The player can not receive FM broadcasting.
A : The bundled earphones operates as an antenna. Stretch the

wires not to be entangled while listening FM radio. 
A : Move to other locations where you can receive the reception

and enhance its quality. 
A : Check whether you set mute. 

In that case, deactivate mute operation.(Refer to page 32)

Q : After the files are downloaded, the playlist will not show the
newly added files.
A : Upgrade the list in Setup menu.
A : Format the product and download the file.

- If you format MP3 player, all data in it will get lost.

Q : After the firmware is upgraded, MP3 player is not normally
functioning.
A : Reset the product (See page 16)
A : Back up the data and format MP3 player.

- If you format MP3 player, all data in it will get lost.

Q : Sometimes, files are not downloaded.
A : Check the PC Connection Setting of MP3 player. 

(See page 11 - 12)
A : Check the PC Connection Setting. Some files can be down-

loaded depending on the PC Connection Setting. All files can
be downloaded in MSC mode.

Q : The PC can not recognize an MP3 Player.
A : Check the PC Connection Setting. In the case of  Windows 98

SE/ME, PC Connection Setting should be set to MSC in Setup
Menu.

A : Check if the USB driver on the provided CD is installed.

Q : AVI/WMV file will not play.
A : Only video files transcoded by LG Media Center 

can be played. Make sure the files to be played are converted
by LG Media Center. Refer to the LG Media Center [Help] on
how to transcode your files.

Q :Characters are not shown properly in text files.
A : If the text file is encoded in a format that your text file viewer

doesn't understand, text data seem to be garbaged or cor-
rupted.

A : You should convert the text file into Unicode on a PC which
supports your language of choice and download it.

A : Set the characters to the corresponding languages in [Settings]
k [General] k [Language].

Q : ID3 TAGs of the music are broken or are not displayed.
A : Set the ID3 TAGs to the corresponding languages in [Settings]

k [General] k [Language].
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Code Num Correction

001 From the <Download> menu on the Homepage, 
download the newest “ROM” and “VIS.PAC” files, 
and then upgrade with it. Or you can upgrade 
the firmware in LG Media Center. 
[Tools] -> [Firmware update].

002 Reset the player. (Refer to page 16)

003 Contact a LG service center near you. 

004 Delete unnecessary files to ensure enough 
space in the player.

005 Connect the player to PC and delete more than 
30MB to ensure enough space in it.

006 Connect the player to PC to delete the files/
folders.

007 Download the files again through LG Media 
Center. 

008 Set the desired image as a background again into
the player.

009 Set the mode of the player to MTP and synchro
nize files on Windows Media Player 10 or higher 
version.  

010 Connect the player to PC and format it. 
(Or activate the format function on setting menu)
[Settings]k[General]k[Format] 

011 Initialize the player.  
[Settings]k[General]k[Initialize Settings] 

012 Use the player after having the battery fully 
charged.

013 The battery is not compatible with the player.   
Use the confirmed battery.

100 Set the language into English. 
[Settings]k [General] k [Language].

When you try to use non-supported files or services, system errors
happen, or additional measures are needed in the player, the error
codes specified below may be displayed. In that case, please trou-
bleshoot the problems by referring to the corrections as below be-
fore visiting service centers.

Error code display

Code Number



cool style 

Specifications

46

Capacity 2GB/4GB/8GB

File system FAT32

OS for MP3 Player Device Win98SE/ME/2000/XP / VISTA

OS for LG Media Center Win2000 / XP / VISTA

Interface USB 2.0

Dimensions (mm) 48.6 (W) X 82.5 (H) X 10.9 (D)

Weight 50g (with battery) / Depends on the product model.

Operating temperature 0°C + 40°C

Frequency range 20Hz ~ 20kHz

Signal-to-noise ratio 90dB

Channel seperation 25dB (1kHz)

Maximum output 5mW+5mW

Frequency range 87.5~108MHz

Signal-to-noise ratio 50dB

Channel response 22dB (1kHz)

Antenna Earphones antenna

Video About 4.5 hours

Audio About 24 hours (for 128Kbps/44.1KHz EQ 
normal)

AC adapter DC5V, 1A

Battery (Built-in) Lithium Ion DC 3.7V 750 mAh chargeable battery

Audio MP3, OGG, WMA, WAV (ADPCM), ASF

Video LG AVI (30 frames), LG WMV (30 frames)

Image viewer JPG, BMP

Text viewer TXT

TFT LCD 2.2" / 260,000 colors

Memory

PC

General specifications

Audio

FM radio
(Optional)

Playback time

Power supply

Type Item Specifications

http://www.lge.com
Information related to the product is available at this site.
- By updating the firmware, you can improve the performance of the product.

Note
Some parts of the storage space of the MP3 player are usually used for storing the information that is internally treated.
Therefore, the storage capacity that can be actually used may be somewhat smaller than specified in the manual.
(The size of the storage space for the internally treated information can be changed for product upgrade without any no-
tice to the end users.)

Files

Display
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Supported file specification
MP3 Decoder
- MP3 decoding support specification including variable bit rate (VBR)

MP3 Encoder
- 44.1KHz, (96Kbps, 128Kbps, 192Kbps) Spec
WMA Decoder
- WMA (ASF-audio only) Decode Support

- (S): Stereo,  (M): Mono

OGG Decoder
- Q(-1) ~ Q(9) Support
ADPCM Decoder
- WAV File Format (MS-ADPCM) Decode

32 OK OK OK

40 OK OK OK

48 OK OK OK

56 OK OK OK

64 OK OK OK

80 OK OK OK

96 OK OK OK

112 OK OK OK

128 OK OK OK

144 OK OK OK

160 OK OK OK

192 OK OK OK

224 OK OK OK

256 OK OK OK

320 OK OK OK

Bitrate 32KHz 44.1KHz 48KHz
Mpeg1
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